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About DigivibeMX® Version 11 
 

DigivibeMX® is a versatile, multi-functional software capable of analyzing machine vibration in real time, performing traditional 
route data collection and balancing single-plane or two-plane rotors – in-situ or on Soft Bearing Suspension balancing machines. 
The DigivibeMX® model purchased determines which software capabilities are available for the user. 
 

• DigivibeMX® M10 provides dynamic balancing capabilities only 
• DigivibeMX® M20 provides route and off-route vibration data collection and analysis capabilities only 
• DigivibeMX® M30 combines the full balancing and vibration analysis capabilities of M10 and M20. 
• DigivibeMX® Phantom supports remote machine health monitoring and analysis using our Phantom sensors.  

 
DigivibeMX® combines powerful machine health monitoring tools with easy-to-use functions and easy-to-interpret visual interfaces. 
The software provides immediate capabilities for inexperienced users, and more sophisticated tools for experienced users seeking 
a full range of analysis capabilities. 
  
Functions include: 
 

• Real-time vibration waveform and FFT spectrum analysis. 
• Single-plane or two-plane dynamic rotor balancing with weight calculator. 
• Balancing Wizard enables Soft Bearing Suspension dynamic balancing without trial weights. 
• Automatic RPM filtering. 
• Orbital Analysis. 
• Circular Time Waveform signal rendering. 
• Automatic generation of vibration analysis and balancing reports (compatible with Microsoft Word and Excel 2007). 
• Powerful SQL database. 
• Accuracy up to +/- 0.1 RPM. 
• Up to 2 million lines of resolution. 
• ODS simulation features built into the software, compatible with imported .obj .xaml and .3ds modeling files. 
• ISO or customizable band alarms for Velocity and Acceleration Enveloping. 
• Individual enveloping alarms for establishing machine baselines.  
• Trigger recording. 
• Simultaneous or sequential recording of 2 planes for dynamic balancing. 
• In-Situ recording for balancing. 
• Octave Bands. 
• Machine Learning models. 

  
DigivibeMX® Is distributed with electronic equipment and optional accessories approved by Erbessd Instruments®.  
  
Visit our web page for more information on available equipment.  
http://www.erbessd-instruments.com 
 

  

http://www.erbessd-instruments.com/
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Types of Sensors 
 
DigivibeMX®v11 wired interface systems include the following sensors: 
 
100 mV/G Accelerometers: 
 
Vibration sensors. Their output voltage is proportional to the acceleration of vibration.  
Used for:  

- Dynamic Balancing in 1 and 2 planes 
- Vibration Analysis 
- Route Data Collection 
- Capturing ODS modeling data 

 
Laser Optical Sensor: 

Laser-emitting speed sensor: 
Used for: 

- Measuring rotational speed (CPM or Hz) 
- Dynamic Balancing (Phase Angle) 

 

System Requirements 
 
Minimum requirements of a desktop, laptop or tablet computer* for DigivibeMX® v11 software installation: 

 
• Intel® Celeron® (2.50 GHz / 400MHz) or higher 
• Minimum 4GB DDR2 or higher RAM 
• Windows® 10 or higher operating system 
• SVGA or higher monitor (enhanced for touch screens) 
• 750 MB of minimum disk space 
• 1 USB 2.0 port 
• Internet connection (for software installation and activation) Note- DigivibeMX installs by default in Phantom mode, 

without a license. If you have purchased a license for M10, M20, or M30 software, licensing is done after the default 
installation. License activation may also be accomplished by using the WiserVibe Pro mobile App for iOS and Android 
devices for offline activation. 
 

Other Required Software: 
- MySQL Connector Net 6.5.4 (Included with system purchase) 
- SQL Compact server 3.5 SP2 (Included with system purchase) 
- Microsoft Word 2007 or higher (for reporting features) 

  



 
 
 

 3 
 

 
 

Software Installation 
From USB or Download:  Open the DigivibeMX_P_DV11P.11xx folder location in Windows Explorer. 

Open the IMPORTANT INSTALLATION INFORMATION text file and follow the instructions provided. Currently this includes: 

1. Install the MySQL connector by double-clicking on mysql-connector-net-6.5.4. 
2. Install SSCE Runtime by double-clicking on SSCERuntime_x64-ENU. 
3. Install the WebView2plugin by double- clicking on MicrosoftEdgeWebview2Setup.exe. 
4. Install DigivibeMX by double-clicking on the setup.exe file. 

 

 

Product Activation 
 

After installation, launch DigivibeMX® software and select the Activation icon in the Help menu. 

 

 

 

 

Enter your username and activation code in the corresponding boxes. 
The key consists of 16 characters, for example WWWW-YYYY-WWWW-YYYY (do not include dashes). 
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INT4-GX4 (GX-400)                  WiSER1x                WiSER3x                     PHANTOMS 

Calibration 
 
The following Erbessd Instruments interfaces and wireless devices are pre-calibrated on their chipsets. They do not require 
calibration in DigivibeMX® software: 

 

 

 

The following legacy wired interfaces must be calibrated in DigivibeMX® before performing vibration analysis or dynamic balancing. 
Calibration data is unique and specific to each individual interface. Therefore, it is also necessary to ensure the interface being used 
is correctly identified in the software before collecting data. Otherwise, collected data will likely be displayed inaccurately. This 
procedure is required during initial product activation. It will also be necessary to recalibrate if you ever upgrade DigivibeMX® 
software, modify the initial calibration file or completely reformat the computer. 

 

 

 

To calibrate: Connect the 2 or 4 channel interface to the computer via USB. Connect the calibration device to the Op port using the 
5-pin Tachometer cable, as shown. Ensure the computer recognizes that a new device has been installed.  

  

INT2-16A/INT2-17A (I-600/I-700 
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On the DigivibeMX® Configuration menu, click Select Device and verify that DigivibeMX® detects the connected interface. If no 
device is found, exit the software, check all connections, restart DigivibeMX® and recheck. 

 

 

Confirm the interface is detected by DigivibeMX® and click Accept 

 

On the Configuration menu, click Calibration 
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The Calibration window opens. Select your Interface. Select the Channel to which the Calibration device is connected. Then click 
Calibrate.  

 

 
The following screen confirms a successful calibration. DigivibeMX® is now ready for use with the calibrated interface. 
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Other Configuration Menu Controls 

Signal and Channel Preferences 
 
Users should review the Signal and Channels settings in Preferences and make desired changes, before attempting to record or 
analyze data. Open the Configuration Menu and select Preferences: 
 

 

The Preferences window opens, containing tabs for user-defined options. 

The Signal Tab 
 

The Signal tab is used to specify default data recording, filtering and display parameters.  

• Resolution Lines: Specifies the default lines of resolution for data 
collection. Detailed information about how the specified Resolution 
Lines affect Resolution Points and Frequency Range are also displayed. 
Adjustments can be made for specific data collection points when 
creating Routes, as desired. 

• RMS Filter Hz: Sets RMS filter range. Default is 11-11000 Hz. 
• Remove DC: Removes drive current from the interface cable. 

• Low Frequency Filter button: Toggles the low-frequency filter ON or 
OFF. Eliminates the low frequency ski-sloping and hay stacking noise 
traditionally seen in FFT displays. 

• Units: Select between Imperial or Metric default units.  
• FFT Frequency: Select between Hz, CPM or Orders default units. 
• Scopes attach: When checked, the Time Waveform and FFT are 

displayed in the same amplitude units. To see different units for TWF and 
FFT, leave unchecked. 

• Allow Panelized Scopes: Activates panelized display in the Analyze 
window. Opens signal files in separate panels. 

• Type Interface: Identifies the current or most recent DigivibeMX 
Interface model connected. Should be confirmed prior to data 
collection.  

• Advance Settings: Enables the Calibration settings portion of the Signal 
tab, if applicable. It is not recommended to make any adjustments to 
these settings without the assistance of an Erbessd Instruments support 
engineer, as changes to these settings will affect the accuracy of 
connected interfaces. 
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Channels Tab  
 
The Channels tab is used to specify sensor Type and Sensitivity for up to 4 channels. 
NOTE: Sensitivity, Type and Trigger controls are inactive until a channel is selected. Channel 3 is inactive with the wired GX-400 
interface, unless the optional splitter cable is used. 
 
 Sensitivity: Specifies the sensitivity for the installed sensor. Unless 

specialty accelerometers are specified, all Erbessd Industries 
accelerometer device sensitivity is 100 mV/g. The Laser Optical 
Sensor sensitivity is 130 mV/g. 

 Type: Identifies whether the sensor is an Accelerometer, 
Velocimeter, Proximity Probe or Optical Sensor  

 Trigger: Toggles default vibration trigger setting between Active or 
Inactive (portable instruments only).  

 

Phantom Tab 
The Phantom tab is used to allow the Phantom Menu to be displayed or 
hidden, as desired. The Show Alarms Messages section allows the 
length of time to be set for Phantom sensor alarm messages  to be 
displayed at the bottom of the DigivibeMX screen. 

 

 

DB Settings Tab 
The DB settings tab is used to change the default location of the local database files stored on a PC/tablet. 

EI-Analytic Connection Tab 
The EI-Analytic tab is used to select which TCP port is used to communicate using HTTPS with an EI-Analytics cloud database. 
Well-known TCP port 443 or non-standard port 3030 can be selected. 
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Specify USB or WiFi Connected Interface 
 

Select USB Connection when using a USB-connected GX400 or legacy interface to collect data. 

 

Select Wifi Connection when using WiSER1x or WiSER3x wireless sensors to collect data. After the sensor is connected to the 
receiving device via Wifi, select the yellow Connect Wifi plug to pair the sensor with DigivibeMX software.  

 

  



 
 
 

 10 
 

 
 

 

Navigating DigivibeMX® Software 

User Interface 
DigivibeMX® version 11 has a classic Windows-style appearance. The software is organized by Menus. Each Menu features toolbars 
with control buttons. However, DigivibeMX® version 11 has been specifically designed to be portable and touchscreen friendly. 

The User Interface is divided into 3 main sections: 

• Section 1: Menus and Toolbars. 
• Section 2: Data Tree and Shortcut Tabs (Start Menu) / Signal Values (Analysis Menu – M20, M30, Phantom). 
• Section 3: Quick-launch Tiles (Start Menu) / Analysis and Work Area for other software functions. 
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Menus and Modules 
The graphic user interface of DigivibeMX® Version 11 has been designed with intuitive menu options, touchscreen compatibility 
and easy access to functions. Certain menus and modules may not be available, depending upon the software model purchased. 

MENU M10 M20 M30 PHANTOM 
File Manager √ √ √ √ 

Start √ √ √ √ 
Data Base  --- √ √ √ 

Analyze  √ √ √ √ 
Functions  --- √ √ √ 

Envelope Alarms  --- √ √ √ 
3D (ODS)  --- √ √ √ 
Phantom  --- √ √ √ 

Tools  √ √ √ √ 
Configuration  √ √ √ √ 

Help  √ √ √ √ 
In Situ Balancing √ --- √ --- 

SBS Balancing  √ --- √ --- 
Portable Routes  --- √ √ --- 

 

File Manager (All DigivibeMX Models) 

 
The File Manager icon opens options to: 

• Launch one of several New common tasks. 
• Open a recorded file or database. 
• Save an off-Route vibration recording – into the current database or as an independent file. 
• Open the Connect to WiserVibe function.  
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The WiserVibe Connector function allows connectivity between a mobile 
device (iOS or Android) using the WiserVibe Pro App and a Windows® device 
running DigivibeMX software. Note – both devices need to be on the same 
data network subnet! A QR code is displayed for the mobile device’s camera 
to scan in order to transfer files between devices. This feature can also be 
accessed via the Configuration menu.  

 

 

 

 

 

Compatible File Types 
DigivibeMX® supports 7 different file types as shown in the following table: 

Extension Compatibility Description 

.anl DigivibeMX® Files of vibration analysis for 1 or more channels. 

.asc DigivibeMX®,  Text file containing all data in Alpha-Numeric format. 

.bal DigivibeMX® 
Balance Calculator session, retrieves all the information 
entered into the calculator. 

.uff Universal File Format 
This file is used by many vibration analysis software and ODS 
programs. 

.wav Sound file This file is compatible with any audio software. 

.jpg 
Image viewer It is used in vibration graphics and polar graphs. It is elective 

between BMP and JPG 

.bmp 
Image viewer It is used in vibration graphics and polar graphs. It is elective 

between BMP and JPG 
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Start Menu (All DigivibeMX Models) 
 
Options and control buttons on the Start Menu will vary depending on the software model purchased. The picture below 
represents M30 with all available features.  
 

 
 

Measure toolbar 
• New Analysis: Starts a new Off-Route Vibration Analysis recording session. Opens the Analysis Menu and Waveform/FFT 

window in the Analysis and Work Area (M20, M30). 
• Long Signal Recording: For collection of Off-route data with recording times up to 1440 minutes. 
• Open: Opens a File Explorer window for navigating to and opening a saved Vibration Analysis recording file (All 

DigivibeMX models). 
• Multiple File Selection Allows multiple signal files to be opened concurrently by selecting them from the Data tree on 

the left side of the screen. 

Balancing toolbar 
• In Situ: Starts a new Dynamic Balancing session and launches the Influence Coefficients Balancing module (M10, M30.) 
• SBS: Starts a new Balancing session and launches the Balancing window and the SBS Balancing Wizard (M10, M30).  

Routes toolbar 
• New Route: Launches the Route creation window. Used to create new Vibration Analysis Routes from available machines 

in the current database. 
• Start Route: Launches the Route data collection module. Used load and collect an existing Vibration Analysis Route for 

machines in the current database. 
• Code Route: Launches the Route to collect an existing Vibration Analysis Route by scanning machine barcodes assigned 

in DigivibeMX. 
• New Schedule: Launches the Route Schedule window. Once created, Routes can be scheduled as a reminder to take 

measurements. 
• Route Compliance: Launches the Route Compliance window. This feature is used to show the history of Route 

performance. It can show Routes completed or overdue by date range. 

EI-Analytics toolbar 
• Login: Launches the Login screen for access to the Erbessd Instruments EI-Analytic cloud database service. 
• Logout: Once logged into EI-Analytic, this icon provides the Logout function.  
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Machine toolbar 
• Machine Manager: Opens the Machine Manager window. This is used to create and edit the machines database and to 

administer bearings, gearboxes and the Machine Learning feature. (M20, M30, Phantom) 
• 3D ODS: Starts a 3D ODS simulation session. (M20, M30, Phantom) 
• 3D ODS Real Time: Starts a Real-time 3D ODS simulation session. (M20, M30, Phantom) 

Reporting toolbar 
• New Report: Launches the Reports module. 
• Trends: Launches the Tendencies Dashboard. 

Help toolbar (All DigivibeMX models) 
• Help Index: Launches the Table of Contents of the DigivibeMX User Manual.(PDF) 
• Remote Support: This is a TeamViewer QuickSupport download link, allowing Erbessd Instruments technical support 

engineers to assist via remote access. 
• Video Tutorials: This links to the Erbessd Instruments YouTube channel for viewing video tutorials. 

 

Data Base Menu (M20, M30, Phantom) 
 

 

Machine toolbar 
• Machine Manager: Opens the Machine Manager window. This is used to create and edit the machines database and to 

administer bearings, gearboxes and the Machine Learning feature.  
• Notes: Opens a window to create a tool-tip style note at the machine or point level in the database. 

Connection toolbar 
• New database: Opens a File Manager window to create a new SQL, SQLCe or MySQL database. 
• Connect: Connects DigivibeMX to a different SQL, SQLCe or MySQL database. 
• Refresh: Once a database is open, this will refresh the screen to reflect changes made to the database. 

Synchronize toolbar 
• Synchronize: Opens the database synchronization window. This feature provides synchronization between a source and 

a target database, e.g., an EI-Analytics database to a local SQLCe database. Note this function supports 15 days of data to 
be synchronized at a time. 

• Backup: Opens the Database Backup window. This allows an entire database to be backed up from source to target, e.g., 
an EI-Analytics database to a local SQLCe database or vice versa. 
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EI-Analytics toolbar 
• Login: Launches the Login screen for access to the Erbessd Instruments EI-Analytic cloud database service. 
• Logout: Once logged in, this icon provides the Logout function.  

Tools toolbar 
• Explore: Opens a window to explore the SQL database tables. 
• Utilities: Opens a toolbar with options to Update a database version, Repair a database, Compact a database, or Open 

the database importer. 
• Database Size: This opens a small window that displays the currently loaded database size in Gigabytes. 
• Shrink Database: This opens the Shrink Database window that provides two functions. 1) Delete old files from a 

database and 2) Extract Files (Time waveform and FFT) from the current database and store them elsewhere. These files 
are not deleted, just relocated. 

Analyze Menu (All DigivibeMX Models) 
 

 

Note – Depending on the screen resolution of the display you are using, some of the Analyze Menu toolbars such as Markers, 
Scope tools, FFT tools, TWF tools will be collapsed, as shown below. 

 

Measure toolbar 
• New Analysis: Launches a new off-route analysis screen. 
• Connect WiFi: Connect the DigivibeMX software to a WiSER1X or WiSER3X sensor that is already connected to the 

device via Wi-Fi. The Record button will not appear until this connection is successful. 
• Record: Starts a manual off-route data recording. 
• Stop: Ends a manual off-route data recording or live, real-time recording. 
• Real Time: Starts a live, real-time recording. 
• Trigger: Sets a recording to begin when the preset Trigger vibration threshold is reached. 

Sound toolbar 
• Play icon: Plays the audio of a displayed vibration data collection. 
• Stop icon: Ends audio playback of a displayed vibration data collection. 

Channels toolbar 
• Channels: Selects the number of channels to record for an off-route data collection. 
• Add Channel: Adds another channel of data from the database or external file for analysis. 
• Delete: Removes a channel of data from analysis. 
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Markers toolbar 
• Notes: Opens the window to create a tool-tip style note. 
• Marker: Allows the user to place custom markers on the Time Waveform or FFT. 
• Clear: Clears all markers from the Time Waveform or FFT. 

Common Markers toolbar 
• Save: Saves all markers placed on the Time Waveform or FFT to be recalled later for other signals. 
• Load: Loads previously saved common markers to be displayed on the signal. 

Specific Markers toolbar 
• Save: Saves all markers placed on the Time Waveform or FFT to the currently viewed signal only. 
• Load: Loads previously saved specific markers to be displayed on the signal. 

Scope tools 
• Toggles on and off the visible legends shown on the right side of the Time waveform and FFT panels of the Analysis 

window. 

FFT Tools toolbar 
• Harmonics: Displays 1 – 10 harmonic marker lines from a selected point in the FFT. 
• Sidebands: Displays 1 - 4 sideband marker lines from a selected point in the FFT. 
• Averages: Recalculates the FFT using up to 10 averages (default view is 1). 
• Overlap: Allows the user to overlap the FFT up to 90 times. 
• Decibels: Displays the FFT in Db amplitude. 

TWF Tools toolbar 
• Circular TWF: Displays the Time Waveform in a circular pattern based on a selected frequency. 
• Transient: Displays interval sideband markers from a selected point in the Time Waveform . 

TWF and FFT Distance toolbars 
• Horizontal: Allows the user to measure between two points horizontally in the TWF or FFT. 
• Vertical: Allows the user to measure between two points vertically in the TWF or FFT. 
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Functions Menu (M20, M30, Phantom) 
 

 

 

Single Channel Function toolbar 
• Circular TWF: Displays the Time Waveform in a circular pattern based on a selected frequency. 
• Waterfall: Displays a cascading 3D FFT representation of the vibration signal. 
• Spectrogram: Color representation of signal amplitude. 
• Frequency 0: Frequency calculation based on the time elapsed between crossings of 0 axis. 
• FFT: Amplified frequency spectrum. 

 

Dual Channel Functions toolbar 
• Bode: Bode chart for calculating resonant frequencies. 
• Phase: Graphic that represents the Phase in each frequency of the whole spectrum. 
• Cross: 2 signal crossing function to weight matching frequencies. 
• FRF (Frequency Response Function): Measures the output spectrum of a system in response to a stimulus. 
• Coherence: Statistics to examine the relationship between 2 data collections. 
• Orbit: Dynamic 2D representation of rotor shaft displacement. 
• Cascade: Displays a 3D cascade graph of several waveforms or FFTs (highlight multiple desired readings in the Historic 

Measures screen to activate Cascade). 

Envelope Alarms Menu 
 

 

Show Alarms toolbar 
• Show Alarms: Displays all envelope alarms set on the current recording (if any). 
• Green: Displays or hides the lowest level alarm envelope. 
• Yellow: Displays or hides the mid-level alarm envelope. 
• Red: Displays or hides the highest level alarm envelope. 

Configuration toolbar 
• Report: Displays alarm levels set at each monitoring point and axis on the machine to which the current recording 

belongs. 
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• Set Alarms: Uses the current recording’s FFT to set envelope alarm parameters that will be applied to each recording at 
that monitoring point (select Set Alarms, click Wizard) 

 

 

3D Menu (M20, M30, Phantom) 
 

 

Create toolbar 
 ODS: Opens the 3D ODS simulation Control Panel for a 

selected machine in the database (select ODS configured 
machine from the database, select 3D Menu, select ODS). 

Play ODS toolbar 
 Play: Starts movement of the 3D ODS simulation. 
 Pause: Pauses the simulation. 
 Stop: Stops the simulation. 

Speed toolbar 
 Down: Decreases the simulation speed. 
 Up: Increases the simulation speed. 

Amplitude toolbar 
 Decrease: Decreases amplitude of the simulation movement. 
 Amplify: Increases amplitude of the simulation movement. 

Tools toolbar 
 Copy: Export the 3D ODS simulation as a still image file. 
 GIF: Export the 3D ODS simulation as a moving GIF file. 

 
NOTE: For detailed instructions about using 3D ODS functions, please refer to Page 88. 
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Phantom Menu (M20, M30, Phantom) 
 

 

Phantom toolbar 
• Wizard: Opens the Phantom Management window used to add, edit, replace or delete Phantom sensors. Also includes a 

Battery Calculator tool and shortcuts to GPIO sensor administration and Power off configuration windows. 
• Status: Opens the Phantom status window to view current status. Info includes firmware version, battery level, signal 

strength, and time of the latest update. 
• Signal Strength:  Opens the Signal Strength window to view the signal strength of Phantom sensors. Note – signal strength 

info is also included in the Status window. 

Set up toolbar 
• Add GPIO Sensor: This button provides a shortcut to the General purpose I/O (GPIO) sensor administration window. This 

function is also included in the Phantom Wizard. 
• Power Off Configurations: This is a shortcut to the Power Off Configurations window. This function is also included in 

the Phantom Wizard. 
• Alarms Set up: Is a shortcut to administer Alarm Notification thresholds for Phantom sensors. This is also found in the  

Phantom Wizard as part of adding or editing a Phantom sensor config. 

Tools Menu (All DigivibeMX Models) 
 

 

Severities toolbar 
• ISO 10816: Opens the ISO 10816 machine vibration severity chart (velocity units) 
• Envelope: Opens the acceleration enveloping machine vibration severity chart (acceleration enveloping units) 

Bearings toolbar 
• Add Bearing: Opens the Bearing Finder window. Allows users to search for bearings in the included database or add 

a custom bearing configuration. 
• Bearings Info: Opens the Bearing database. 

Gearboxes toolbar 
• Add Gearbox: Opens the Gearbox window to add, edit, or delete a Gearbox from the database. 
• Gear Frequency: Opens the Gear Calculator window. 
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Extras toolbar 
• Print Machine Codes: Opens the QR Code generation window to create and print QR Code labels. 
• 3D Model Editor: Opens the 3D ODS Control Panel for editing or importing 3D ODS models. 
• Advance tendency: Opens the Advance Tendency Dashboard for detailed machine health severity analysis. 

Exports toolbar 
• Export to UFF58: When a signal is open for analysis, this button will export the selected raw data (time waveform 

and/or FFT) to a file in UFF58 format. 
• Export to  ASCII: When a signal is open for analysis, this button will export the selected raw data (time waveform 

and/or FFT) to a file in ASCII format. 
• Export to CSV: When a signal is open for analysis, this button will export the selected raw data (time waveform 

and/or FFT) to a file in CSV format. 

Imports toolbar 
• UFF58 Import: Imports signal data for analysis from a UFF58 format file. 
• ASCII Import: Imports signal data for analysis from an ASCII format file. 
• CSV Import: Imports signal data for analysis from a CSV format file. 

Configuration Menu (All models) 
 

 

Settings toolbar 
• Preferences: Configures DigivibeMX® software and hardware for balancing and/or data collection. 
• Change Language: Allows selection of language. Currently 9 languages are supported. 

Device toolbar 
• Calibration: Calibrates the software using the calibration device and 2/4 Channel interface. 
• Select Device: Used to verify and select a connected interface. 
• USB/Wifi Connection: Toggles DigivibeMX input sources between USB-connection and WiFi-connection devices 

(WiSER1x and WiSER3x).  
• Connect Wifi: After a WiSER1x or WiSER3x is connected to a PC/tablet via Wi-Fi, this button connects DigivibeMX 

software to the sensor. 
• Connect to WiserVibe: The WiserVibe QR Connect function allows connectivity between a mobile device using the 

WiserVibe Pro App and a Windows device running DigivibeMX software. A QR code is displayed for the mobile 
device’s camera to scan, in order to transfer files between devices. Note: Both devices must be on the same data 
network subnet to use this feature. 
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Help Menu (All models) 
 

 

DigivibeMX Update toolbar 
• Check for Updates: Checks the Erbessd Instruments server for updated software versions. DigivibeMX v11 updates 

can be performed immediately or downloaded for later installation. Note- DigivibeMX software automatically checks 
for newer versions of software every time it launches and will open a notification window if a newer version is found. 

• Release Notes: This opens a PDF file containing the Release Notes for the current and previous versions of 
DigivibeMX v11. This includes all Improvements and Bug Fixes for each release. 

Help toolbar 
• Help Index: Launches the Table of Contents of the DigivibeMX User Manual.(PDF) 
• Remote Support: This is a TeamViewer QuickSupport download link, allowing Erbessd Instruments technical 

support engineers to assist via remote access. 
• Video Tutorials: This links to the Erbessd Instruments YouTube channel for viewing video tutorials. 

Activation toolbar 
• Activation: Launches the License Activation window for licensing models M10, M20 and M30. 
• Offline Activation: Used when no Internet connection is available to License DigivibeMX v11 software. 

WiserVibePro toolbar 
• Device Activator: Select this option to display a QR code used in conjunction with the WiserVibe Pro mobile App 

License Activation feature. This can be used to activate a DigivibeMX software license when no internet connection is 
possible for the device with DigivibeMX installed. 

View Options toolbar 
• Clicking the down arrow on the right side of the View Options toolbar allows you to select from one of 18 skins to 

customize the appearance of DigivbeMX. 

 

About toolbar 
• About: Displays software version and copyright information. 
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Using DigivibeMX® Software 
 

DigivibeMX® is a powerful and versatile Condition Monitoring software. It empowers users with industry-leading vibration analysis 
and dynamic balancing capabilities. New tasks open in one of two ways: 

• In a tabbed window of the Analysis and Work Area, which allows switching between several tasks in progress. Individual 
tabs can be closed when tasks are complete.  

• As a separate module of the software, which can be closed when the task is complete (Route data collection and 
Balancing functions) 

Start Tab 
Features large quick-launch tiles to make selecting and launching key functions easier in a tablet computer environment. The 
pane can be scrolled horizontally by holding the mouse left-click button and dragging the screen, by rolling the mouse scroll 
wheel, or with a finger slide on touchscreens. Tiles may be rearranged as desired.   
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Start Screen tiles 
 

Open Files tile (M20, M30, Phantom) 
Opens the Historic Measures tab, which allows selection of vibration signal recordings from the database for analysis. 

  

 

Trends tile (M20, M30, Phantom) 

Opens the Dashboard Tendency tab, which allows trending of vibration data from the database in real values (acceleration, 
velocity, displacement, acceleration enveloping) or severity (score). 
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Extra Parameters tile  
The Extra Parameters tile is used to display non-vibration information collected by Phantom Sensors such as Temperature, RPM, 
Electrical Current, Thermal Images, GPIO sensor outputs, etc. All data, except vibration signals, is accessed via the Extra 
Parameters tile. For all vibration signal files, use the Open Files tile. 

 

 

When the Historic Extra Parameters window opens, click on Choose Parameter; the available options will be displayed. 

 

Analysis tile (M20, M30) 
Opens the Analysis tab for collecting and analyzing off-route data. 
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Route (Open) tile  
Opens the Route module for loading and collecting an existing route. 

 

 

 

 

 

Barcode tile (M20, M30) 
Opens the Barcode reader. A scanned machine then opens in the Route module for vibration data collection. 
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Routes Manager tile (M20, M30) 
 Opens the Routes window for creating new vibration data collection routes from machines in the current database. 

 

 

 

 

 

 

In Situ Balancing tile (M10, M30) 
Opens the Balancing module to perform 1 and 2 plane balancing using the Influence Coefficients method. For details regarding In 
Situ and SBS balancing, see Balancing User Guides. 
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SBS Balancing tile (M10, M30) 
Opens the Balancing module for 1 and 2 plane balancing for Soft Bearing Suspension balancing machines. Also opens the 
Balancing Wizard tool used with SBS balancing. For details regarding In Situ and SBS balancing, see Balancing User Guides. 

  

 

 

 

 

 

 

ODS tile (M20, M30) 
Selecting a 3D-model assigned machine from the database, then selecting the ODS tile opens the machine in the ODS control 
panel. 
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Left-Hand Panel and Shortcut Tabs 
The left-hand panel, also known as the Data Tree, provides information related to the current database or tasks in progress. It 
also features two shortcut tabs, allowing quick transition between viewing the Database and Analysis tasks in progress. 
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Database Tab 
The Database Tab provides navigation within the currently-opened database. This is  a file and folder system where all collected 
data is stored. The DigivibeMX® database is compatible with SQL, MySQL, SQLCe file formats. For specific Data Base Menu features 
and functions, please refer to the “Using the Data Base Menu" section on page 
44.  

Database folders and files are displayed in a standard tree format. Database 
hierarchy is as follows: 

1. COMPANY: This is the highest level in the database Typically this is 
configured using the Company Name, Customer Name or Plant Location (for 
service providers or other users collecting data in multiple plant locations). 

2. AREA: This usually defined as a Production or Process Area or a building 
name. 

3. MACHINE: Each machine is assigned a unique Machine ID. 
4. POINT: Bearing or measurement location on the Machine. 
5. AXIS:  H (horizontal), V (vertical), A (axial) or R (reference channel for ODS 

rendering). 

NOTE: Names are assigned to Company, Area, Machine and Points in the 
database. The only special character permitted in these name fields is the 
underscore.  

If Machine Alarms are used, each level of the database will display the highest severity alarm for any collected data it contains. 
The colors displayed reflect the most current data. This includes RMS data. For example, if a Phantom sensor reported a yellow 
alarm condition, based on the configured alarm threshold, and subsequently reported a green RMS reading, the color shown will 
be green. 

The data tree can be filtered to display various information such as 
Velocity(default), acceleration, etc. If alarms are configured for the parameter 
chosen, the display will reflect the corresponding colors. 

NOTE: Right clicking on items in the Database 
opens a context menu. Active options available 
from the menu will depend upon the level of the 
item selected. 

 
 
 
 
 
 
  

Company 

Area 

Machine 

Point 

Axis 
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The    button unpins the left-hand panel from its default location. The panel can be moved to the right-hand side of the 
Digivibe screen, stacked above, below or hidden. Click and hold the unpinned panel and drag toward the center of the screen. An 
orientation diagram appears. Drag the panel to the new desired position on the diagram. 
 

 

Analysis Tab 
 

The Analysis tab opens the telemetry panel for Vibration Analysis and Off-Route data 
collection. Up to 4 channels of data may be simultaneously displayed and compared.  

The Analysis panel has 2 information tabs: Values and Analysis.  

The Values information tab displays the following values of collected vibration data for 
each channel. 

• RMS: Root Mean Square of overall vibration.  
• Max: Maximum amplitude FFT peak. 
• Max Freq: Frequency of highest FFT vibration peak. 
• Peak to Peak: Amplitude of the waveform from its highest to lowest peak. 
• Crest Factor: Compares how close the waveform is to a pure sinusoidal 

waveform value of 1.414. 

The  button hides the displayed information. 

The  button restores the hidden information.  
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The Analysis information tab features several key functions for 
quickly analyzing common concerns.  
 
– Reference Channel button: Used to select the channel to which 
analysis functions will be applied. 
- Frequency and Arrow buttons: Used to select or specify the 
desired fundamental frequency to compare relative phase or 
calculate bearing and gear fault frequencies. 
 
- Markers: Places markers on the FFT spectrum for the Max, Max 5 
or Max 10 frequencies, as desired. 
 

 

- Phase: Shows the relative phase comparison for all channels open 
for analysis (up to 4). 
 

 
 
- Bearings & Gearboxes: Displays bearing and gearbox fault 
frequencies assigned during machine building in the database. If 
none are assigned, they may be added using the Bearing and 
Gearboxes tools.  
 

 
 
- Values Field: Displays values for the specified Markers, Phase, or Bearing & Gearbox calculations.  
- Clear list: Clears data from the Values Field. 
- Delete last: Deletes the last value calculated from the Values Field. 
- Draw: Places corresponding markers on the FFT spectrum for values displayed in the Values Field. 
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Analysis and Work Area 
The Start screen, new tasks and functions open as tabbed windows in the Analysis and Work Area. 

 

 

This format allows users to easily switch between various tasks in progress. When a certain task or function is no longer required, 
its tab may simply be closed. The only exceptions are Dynamic Balancing and Route Data Collection functions, which open 
separately in their own independent software modules. 

Historic Measures window (M20, M30, Phantom) 
 

Used to open recorded signal files stored in the database.  

On the Start tab, select the Open Files tile to open the Historic Measures window. 

 

Selecting the Company level in the data tree displays the most severe data collection for each Area. 
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Selecting the Area level in the data tree displays the most severe data collection for each for each Machine in that area. 

 

Selecting the Machine level in the data tree displays the most recent collections at each Point and Axis for that machine. Select 
Open File to open the Time Waveform and FFT in the Analysis window. 

 

Selecting the Point level in the data tree displays the most recent collections at each Axis for that point. Select Open File to open 
the Time Waveform and FFT in the Analysis window. 

 

 

Selecting the Axis level in the data tree displays all historical collections at that axis. Select Open File to open the Time Waveform 
and FFT in the Analysis window. 
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To view the file path where the current database is located, hover the cursor over the left-hand Database tab. 

 

IMPORTANT: The Historic Measures window displays signal files sorted by the DATE. The default date range is one month from 
the current date. 

Clicking on the date button opens a Selector window to change the date range. 
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Opening Multiple files 
Click the Multiple File Selection button on the Start Menu. 

 

The Data tree will change to include check boxes for each level of the database. By using the check boxes, multiple selected signal 
files can be shown together in the Historic Measures window. 

 

 

Historic Measure window tools 
 

RMS: For Phantom sensors, RMS velocity data is collected periodically and stored in the database. To toggle the display of RMS 
data, use the RMS toolbar button. This icon will be greyed out for data collected by portable sensors such as the WiSER3X. 
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The Collection Reason column shows the RMS values as Type:Internal RMS. No signal file (Timewave form or FFT) is created for 
RMS readings. Neither acceleration nor acceleration envelope data is included in the RMS data. 

 

 
Collection reasons include: 
Route: Route data collection from portable sensors, such as WiSER3X. 
Scheduled: Regular collection by Interval or Time-of-day. 
Software Reset: Sensor configuration changed. 
Manual Data:Off-Route signal data was collected and saved to a specific machine point. 
Requested: On-demand request for Recording via software or sensor was reset by magnet. 
Triggered: Recording triggered by another sensor. 
Axis Alarmed: This axis reported an alarm condition. 
Axis Not Alarmed: One of the other two axes of this machine point reported an alarm condition (triaxial sensor). 
Internal RMS: Velocity RMS calculated by the sensor. 
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Cascade: To open multiple readings in a cascade plot, highlight the desired readings (drag down the list or Ctrl+click to select 
desired rows) and select the Cascade icon  

 

 

Mode: Choose between TWF, FFT or Trends view.  

Settings:  

• Increase or decrease zoom on the X or Y axis. 
• Switch between 2D or 3D view. 
• Toggle point name labels on/off. 
• Toggle severity indication on/off. 
• Toggle filter on/off. 
• Select amplitude units to display.  

The check boxes can be used to display or hide 
selected recordings. 

Use the Copy button to copy the cascade plot to 
the computer clipboard and paste into a Word document, email, etc.  

 

The Historic Measures tab  Copy button copies data from highlighted cells to paste into Excel, Word, etc.  
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The Enter Data Manually button allows data to be manually entered into the database. 

 

 

Clicking on Delete opens the Delete Manager window which allows filtering of data for deletion. For example, if the Delete Only 
Files radio button is selected, as shown below, only full data collection files will be deleted, the RMS data will remain. Delete All 
Measures deletes both signal files and RMS data. 
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The Delete Multiple Rows button will delete any highlighted rows, but will pop an “Are you sure?” screen first.  

 

 

The Export button allows exporting of data from selected rows to Excel , Word or CSV format files . 

 

The Add Measures button is used to select data to be used to generate an Octave Band chart. 

 

The Remove Measures button removes selected rows from the Octave band chart. 
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The Open Octave Band Chart button displays the data previously selected in the Octave Bands window. 

 

 

The Octave Band chart can be 
displayed in bar or line graph view, 
be set to CPM or Hz, and show 
velocity or enveloped acceleration 
info. The Frequency Panel can also 
be expanded for more details.  

 

 

 

 

 

 

 

When multiple rows are selected in the Historic Measures window, the Open Multiple Files button may be used to show up to 4 
signals simultaneously. 

 

All signals are shown together, superimposed in the same Time Waveform and FFT windows. 
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Dashboard Tendency window (M20, M30, Phantom) 
 

On the Start tab, select the Trends tile to open the Dashboard Tendency window.  

The Dashboard Tendency window features four panels of machine data trending 
information. The information displayed is determined by the database level and date 
range selected. Information in each of the four panels is derived from the alarms set 
(displacement, velocity, acceleration and acceleration enveloping). Click on the 
desired values in each panel to instantly re-render the graph according to score (severity), vibration amplitude or hidden from 
view. Moving the cursor across a graph produces a cursor line for specific point information. 

For each panel of the Tendencies tab, there is an option to expand the panel to full screen:  

Options to Copy or Save the panel display are found in the Menu.  

 

Save Personal Configuration retains the current options for reviewing subsequent items in the Tendencies tab. The settings will 
revert to default once the current DigivibeMX session is closed. Remove personal configuration resets the options to default. 
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• Parameters panel – Chart display of the last recorded measurement for the database level selected. Left/Right chart scales 
correspond to the nearest value displayed. Parameters may be added or removed from the display by clicking on them. 
Those highlighted in Blue will be displayed Data may also be shown in Bar chart mode. 

  

 

• Children panel – Displays the last recording values in pie chart or bar chart view for children under the parent database level 
selected. 

 

Selecting 2 Prev. Months updates the display accordingly and toggles the button to allow reverting to Current: 
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• Behavior Over Time panel – Displays a trend line of highest values of the day for children under the selected parent level of 
database, for the date range selected. Left/Right chart scales correspond to values selected.  

 

 Click on the Day button to change the date range to be displayed.  

 

 

• Time of the Day panel – Displays the highest severity or amplitude collection on the indicated day and time. The blue bars 
indicate data collections. Higher score or amplitude recordings appear darker. Hovering the cursor over a blue bar displays 
the corresponding value. 

• Show RMS button: Toggles the addition of RMS data to the trends display. 

The Expand panel button will expand the selected panel to full screen mode. 
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Using the Data Base Menu (M20, M30, Phantom) 
 
The Database Menu features tools to manage the three database types compatible with DigivibeMX® - SQL, MySQL and SQLCe. 
 
Toolbars on the Data Base Menu include: 

• Machine toolbar: The Machine Manager is used to create, edit, or delete machines, bearings and gearboxes. Machine 
Learning may also be configured here, as well as the Notes feature. 

• Connection toolbar: Create, connect to and refresh databases with recent updates. 
• Synchronize toolbar: Used for the Synchronize and Backup database features. 
• EI-Analytics toolbar: Login and Logout of an EI-Analytic database (with subscription.) 
• Tools toolbar: Explore the data tables and database Utilities, show current database size and use the Shrink Database 

feature. 

 

Machine Manager 
Opens the Machinery Management window. Note: This web-based interface is 
identical when using DigivibeMX, EI-Analytics via a web browser or the WiserVibe 
Pro mobile App. 

 

Add Machine: Opens the Add Machine window for adding new machines to the 
database.  

Copy Machine: Copies an existing machine for quick additions. This works well 
for creating multiple machines with the same parameters, e.g., RPM, bearings, 
etc. 

The Rename feature allows renaming a Company, Area, Machine, or Point. 
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Edit Machine: To select a machine for editing, click on the arrow beside the machine name. The Edit function can be used to 
change a machine’s Company or Area assignment in addition to all other fields in the machine configuration. 

Delete Machine: Select from the list to delete a machine. 

 

   

 

Machine Learning Manager: Opens the Machine Learning window to add or edit machine learning models. 

Apply Machine Learning: Applies a machine learning model to a selected machine. 

Gearbox Add/Edit: Opens the Gearbox window to allow adding and editing of gearboxes in the database. 

Notes: Opens the Notes manager screen to allow adding, editing or viewing notes attached to a machine.  
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Creating a new Machine 
 

The Add Machine screen has two sections, the Machine panel and the Points panel. Contextual Help is available for some fields by 
clicking the blue question marks.  

The Machine panel contains fields for: 

• Company: The company who owns the 
machine. 

• Area: The production area in which the 
machine is located. 

New Company and Area info can be added by 
using the add button.   

• Name: The machine name or ID number. 
NOTE: the only special character permitted 
in the name field is an underscore. 

• Image: Optional 2D image of the machine 
may be uploaded to the database for reports. 
Also, clicking the photo 
button will capture an image 
using the PC camera. 

• 3D Model: 3D ODS models can be selected 
from the DigivibeMX database. External 3D 
models in .3ds, .xaml, or .obj formats can 
also be imported to DigivibeMX.  

• Notes: Text field for documenting additional machine information. 
• Alarms: General alarms may be configured here for non-vibration sensors such as Temperature, Speed, Current, etc. These 

types of sensors may be administered at the Machine level or the Point level in the database. If created at the Machine level, 
the corresponding alarms should be configured here, if created at the Point level, configure alarms in the Points panel Extras 
field as described in the next section. 

• Severities settings origin: Dropdown menu includes Only User Settings(default), Only Machine Learning Settings, Default 
Settings or Machine Default settings. The choice is used to determine the severity color (red, yellow, orange, green) of the 
icons in the data tree as well as in EI-Analytic and the WiserVibe Pro App.  

• Coefficient: The machine maintenance priority or criticality for severity trending on a 1-10 scale (1 for critical machines, 10 
for non-essential machines). 

• Slope Interval: The time period of data to be considered for machine severity calculations. 
• Code: DigivibeMX automatically generates a unique code(number) that can be used to identify a machine. Click the View 

button to see a unique QR code for scanning purposes. A Manual code may also be entered, or an image created via a device’s 
camera. 

• Task: Opens the Tasks window. NOTE- This feature is only available with an EI-Analytics cloud database subscription; it is not 
currently supported when using local databases. Task Manager provides notifications via email and/or push notifications to 
the WiserVibe Pro App, based on configurable thresholds for velocity, acceleration, etc., for a given machine. 
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Setting Tasks for Machines 
Tasks can be created to notify users of Machine health changes via email and/or push notifications to the WiserVibe Pro mobile 
App. A subscription to an EI-Analytics database is required for this feature to operate. Tasks cannot be assigned when a local 
database is used. 

The Machine Manager allow Tasks to be created/assigned in the Add/Edit Machines windows. Click on the green Notification bar 
to open the Task manager window. When editing an existing machine, previously assigned Tasks will be shown for review or a 
New Task may be created using the New Tasks button.  

  

Select the Units from the drop-down box for which Notification is desired. This includes vibration units of velocity, acceleration, 
and acceleration envelope in addition to non-vibration parameters such as temperature, RPM, Amperage, etc.  
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Then click the green Add button This opens the Tasks window.  

 

 

• Assign a name for this Task. 
• Choose which Axes will cause Notification. 
• Depending on the Units chosen, the Units drop-down box will contain an appropriate list for selection. For example , if 

velocity is chosen, then RMS, Min, Max, Crest Factor, Peak to Peak, etc., will be included. 
• Conditions include Equal to, Less than, Greater than, etc. 
• Value is set for the chosen Units and Condition, such as the example above where the velocity Max Greater than .05 inch/s 

will cause Notification to be sent. 
• Assign a title for the email Notification. 
• Information entered in the Content field populates into the Subject line of the email. 
• Check the Send email green slider to enable email Notification. 
• Email mode can be set to Immediate (send email without delay)or Batch (sends all pending email notifications once a 

day).  
• Time Interval for Emails allows setting a buffer to prevent repeat emails from being sent when immediate mode is used. 

If the condition repeats during the assigned time window, no email will be sent. 
• Time Interval for Push Notifications provides the same function as described with emails.  

Click OK when finished. 

 Multiple Tasks may be assigned to the same machine. E.g., one for Velocity, another for Acceleration. When initially creating a 
database, it is recommended to configure Tasks before using the Copy Machine feature.  
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Configuring Point 1 on a Machine 
Point 1 is created by default in a separate panel. Every machine has a minimum of 1 
point, although it is not used when non-vibration Phantom sensors are assigned at 
the machine level. Click on the up/down arrow to expand or hide the bottom portion 
of the Points panel.  

• Name: Use a naming convention for points that works for you. Names like MOB 
(motor outboard) or NDE (non-driven end) are commonly used. Only 
underscores are permitted as a special character in the name field. 

• RPM: Enter the Min and Max RPM values for the machine point. An accurate RPM 
range is required for Acceleration Envelope calculation and identifying the 
machine’s running speed 

• RPM Range Hz: For high-sensitivity Phantom sensors (V10, V10E) use the default 
range of frequencies from 10 to 1000 Hz. It is recommended to change this for 
high-range Phantom trixial sensors (V11, V11E) to 20 Hz Min and 1000 Hz Max to 
get higher precision. 

• Axes: Defaults to triaxial, adjust as necessary. 

Alarms 
These fields are used to set Axis-level severity alarms that determine the color 
displayed in the data tree. Click on Horizontal, Vertical or Axial to set the alarms for 
each axis. This opens the Alarm config window. By default, there are two parameters assigned for RMS alarms - Velocity and 
Acceleration Envelope. 

Click on the large green Add button to add another RMS alarm parameter (Acceleration and/or Displacement). 

 

 

Click on the Edit button to change the default settings, which are based on ISO 10816 Class 2 standards. 
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This opens the Alarm Settings window. Once set, the alarm values can be saved in defaults. 
Previously created alarms can be applied by using Choose from saved option. 

 

The saved choices are accessed via the large drop-down box.  

 

As shown, the ISO Class 2 alarms are the defaults. Once changes are made, click on Save. 

Adding Bearings 
The Select Bearing button opens the Bearing window.  

DigivibeMX v11 features a Bearing database containing fault frequencies of over 40,000 common bearings from major 
manufacturers. Bearings may be permanently assigned to a machine measurement point or specified during Analysis. The 
Bearing database features a Search function, a Manual function for adding new bearings and fault frequencies to the database, 
and a Calculator to calculate bearing fault frequencies using bearing component measurements. 
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Enter complete or partial bearing part numbers to Search the database. Bearings can be manually created using calculated fault 
frequencies or those provided by the bearing manufacturer.  The Calculator can be used to calculate fault frequencies using 
measurements or from data provided by the bearing manufacturer. 

 

Adding a Gear Box 
To assign a gearbox to this machine point, or create a gearbox in the database, click on Select 
Gearbox.  

This opens the Select Gearbox window, used to create a comprehensive library of gearboxes. Once created, the gearboxes may be 
permanently assigned to a machine measurement point or specified during analysis. 

Select a previously configured gearbox from the list or click the +Add button to create a new gearbox configuration.  

 

• Name: Enter the name of the new gearbox. 
• Notes: Add any desired notes. 
• Manufacturer: Select from previously configured list or Click on the button to configure a new 

Manufacturer. 
• Step Name: Add the step name to the Step-1 panel. 
• Input: Enter the number of teeth. 
• Input Bearings: A bearing configuration may be added by selecting the button. 
• Output: Enter the number of teeth. 
• Output Bearings: Add an output bearing, if desired. 

Select the button to configure another step in the Gearbox configuration. 

Click  when finished. The new gearbox will be assigned to the current machine point. 
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• Learning: The Machine Learning feature uses predictive algorithms to analyze 
historical data and thereby identify when notification is to be made regarding the 
health status of a machine point. 

• Extras: In addition to vibration data, Extra Values such as Temperature, RPM and 
Amperage may be documented. Extra Values may be assigned at the Machine level, 
or at a Measurement Point.  Click on the General Alarms button to set alarms for 
sensors that are assigned at the point level. These point level alarms have no 
relation to the Axis alarms previously described. 

Adding a Coupling 
To add a Coupling, click the Add coupling button. 

Enter a name and select which type of coupling is used for this machine. 

 

 

 

 

 

 

To add another machine point, click the green add button.  

 

After adding all machine points, click on Save.  

 

You should see a confirmation message appear.  

 

Note: At the top right of the Add Machine screen is the Options Menu.  

This provides shortcut access to common functions such as Alarms, Coupling and Bearings 
configurations. 

Machine configuration may be saved as a text file by using Save Machine locally. 

Load machine loads a previously saved machine text file. 
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Connection toolbar 
  

New database: Allows a new SQLCe  database to be created. SQL database files can be 
created and saved in any location. It is recommended to keep all database files together in 
an easily-located common folder.The default folder is (Documents > Erbessd Instruments 11 
> Database). Clicking New database opens the Save As window to the default location. 
Specify an alternate location, if desired. Enter the name of the new database in the File Name 
text field. Save as type: SQLCe. 

 

Click the Save button to save the new database. Click Yes for any notification boxes that may appear after the database file is 
created.  

NOTE: SQLCe databases have a 3.5GB capacity limit. It may be necessary to periodically thin the SQLCe database of old data, or 
synchronize the database structure to a new SQLCe database - to avoid having the database refuse new data because it has 
reached its maximum allowable capacity. 

 

Connect: DigivibeMX software cannot create a new SQL Server, MySQL or SQL Azure network database. The empty database must 
be created independently, then DigivibeMX is mapped to the database location. Once connected, DigivibeMX will create the 
required fields and tables. Locating the SQL Server or MySQL database on a shared network server will require entering the 
destination server’s IP address. Locating an SQL Azure database will require the TCP address. Accessing the database may also 
require a database administrator Username and Password authentication. Be prepared with this information before proceeding. 
Consult a local IT administrator or SQL database administrator for assistance.  
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Open the Data Base Menu in DigivibeMX. Select Connect on the Connection toolbar.   

The DB_Open_Network_DB window opens. Select SQL, MySQL or SQL Azure database 
format. Click Local Host button to continue. The Host Select window opens. 
 

 

For a SQL Server or MySQL database, enter the server’s IP address. For an SQL Azure database, enter the TCP address. Then enter 
the Database name. Enter the database Username and Password, if required. Click the OK button to continue.  

The destination address connection string will appear in the DB_Open_Network_DB Connection window. Click the Ok button to 
connect. 

•  If database files are moved between devices or stored remotely, Connect allows mapping DigivibeMX to their new 
location. 

• Refresh: Updates the database view to reflect any new data or modifications. 

 

Synchronize toolbar 
• Synchronize:  Opens the Database Synchronization window. 
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There are three tabs on the left side panel, Machines, Routes, and Phantom. This panel is also divided into Source and Target 
databases. 

Machines tab: Select Source machines for synchronization on the left data tree. The Source by default is the database that you 
are currently using. In this example, the Source is a local SQLCe database. To sync an EI-Analytics database as the Source, first 
login to the desired database, then select Database>Synchronize. 

• Choose options:  
o Machines: Sync or DO NOT sync 
o Measurements: Sync all, only the last measurement, or none 
o Files: Measurements and signal files, or RMS data only 
o Phantom: Include Phantom sensor configuration for sensors assigned to the selected machine(s) 

• Select target Database: Select either local or EI-Analytic, then click Open. 
o Click Open local database Note -You must create a target database before this step! 
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• Select Dates: Click on the Select Dates button and choose a date range for 
synchronization. Up to 15 days may be synchronized at a time. Click on a 
start date, then holding the shift key, select the end date of the range.Click 
Done to execute the sync. 

The right-hand panel shows the synchronization process. The length of time to 
complete the process depends on how many machines and options are chosen. 

 

EI-Analytics toolbar 
• Login and Logout: Enter the Username and 

Password for your EI-Analytics account, and press 
Connect. Check Remember me to save credentials 
for subsequent login sessions. Select the desired 
database from the list and click OK. Once logged-in, 
the Logout button will be available . 
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Tools toolbar 
 

• Explore: Allows manual exploration of the database and data tables.  

Upon clicking Explore, A warning message will appear: 

 
If you assume the risk, click Yes. Detailed use of the Database Explorer is not included in this document. 

• Utilities: Utilities include:  
o Update database 
o Repair database 
o Repair another database 
o Compact engine 
o Open database importer 

 

• Database Size: Click to see the size of the current database. 

 

 

 

 

 

• Shrink Database:  opens the Shrink Database window that 
provides two functions. 1) Delete old files from a database and 2) 
Extract Files (Time waveform and FFT) from the current database 
and store them elsewhere. These files are not deleted, just 
relocated. 
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Data Collection with Portable Instruments (M20, M30)  
 
The Analyze and Functions Menus feature tools for collecting and analyzing machine vibration data. 

New off-route analysis (M20, M30) 
This type of immediate, off-route analysis with a portable instrument is not associated with any machine in the database. It will 
not automatically be saved. Off-route analysis is recommended for spot-checking, troubleshooting or other situations when 
machine vibration data must be displayed, but not necessarily saved to the database. However, off-route data collections can be 
saved by opening the File Manager and selecting Save. Files can be saved to the database under an existing machine. Files can 
also be saved outside the database as .anl files and emailed to other DigivibeMX users for review.  

 

There are two different methods for opening a new immediate, off-route data collection and analysis session:  

Method 1 – New Analysis on the Analyze Menu 

 

 

 

 

 

Method 2- Analysis tile on the Start tab  

 

Both methods open the Analyze Menu, launch the Analysis tab and switch the left-hand panel to the Analysis view. 

 

NOTE: When no interface is connected the recording control buttons will be greyed-out, as shown above. 
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Long Signal Recording 
DigivibeMX 11 version 11.60 supports the Long Signal Recording feature. Signal files up to 1440 minutes in length may 
now be recorded. 

Data may be collected using either a WiSER 3X portable triaxial data collector (Wi-Fi), or a single-axis accelerometer 
connected via a GX400 Interface(USB). 

NOTE - Long Recording files can be VERY large. The example 66 sec recording shown below is 25 Mb in size. A 10 
minute recording will be approximately 250 Mb. A 40 minute recording will be about 1 Gb. These files can take a 
considerable amount of time to load for analysis. 

 

To use this feature, connect to either USB or Wi-Fi interface as usual for an Off-route data collection. 

 

On the Digivibe Start Menu, click the Long Signal Recording button. 
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A new LongRecordingSignal Tab will open. 

The top graph in the analysis window displays the Long Recording time waveform data as the recording takes place. 

 

Set the desired Recording time then press Record to begin.  

 

 

The recording will stop when the Recording Time elapses, or if the Stop button is pressed.  
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The example shows a 66 second test recording. The percentage of total Recording Time is shown at top left (11%). 

 

Use the Time Range field to select an area of the Long Recording to be displayed in the TWF and FFT Graphs below. 

 

For example, 10 seconds. 

 

Press the Select button, then click on a point in the recording (the center of the 10 second range). 

 

 Delete Cursors removes the selected range. 

The folder where the Long Recording files are stored can easily be selected: 
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Analysis of the TWF and/or FFT graphs may be performed on any selected part of the Long Recording. 

 

 

Connecting Portable Sensors 
 

Portable sensors include: 

• Accelerometer connected to a GX400 wired USB interface. 
• WiSER1X single-axis accelerometer (Wi-Fi) 
• WiSER3X triaxial accelerometer (Wi-Fi) 

Wired GX400 interface: Plug in the USB cable from the GX400 to the device running DigivibeMX , then set the Device type to 
USB Connection on the Configuration Menu. 
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WiSER Wi-Fi : Set the Device type to WiFi in the Configuration Menu. Turn on the WiSER sensor. It will create a Wi-Fi network 
called EIWISER. Select the Wi-Fi network named EIWISER from the available networks list on your device. Enter the password 
88888888 (eight 8’s) and click Connect. Once successfully connected, select the Connect WiFi button on the Analyze menu. 

 

The Wi-Fi Connected icon will appear on the toolbar: 

 

The previously greyed-out control buttons will now be available. 
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Off Route Analysis continued 
  

Start/Stop Data Collection 
 

The Analysis tab launches with the default recording parameters specified in the Configuration Menu>Preferences. If different 
resolution lines or recording times are desired, changes can be made prior to recording data. Select the number of data channels 
to be collected (up to 4) from the Channels dropdown. The Time Waveform and FFT will render in real time as data is collected. 

 

 

Data collection is started with and will end automatically, based on the specified Resolution Lines.  
 
 
Data collection can be stopped manually with 
 
 
To monitor a live stream of continuous data, use to begin, then press Stop when finished.  
 
 
NOTE: Real Time data is not saved while monitoring. Only the information visible in the TWF and FFT can be saved when the 
collection is stopped. To record a long TWF, set the recording time to the required duration and press Record.  
 
The function is used in conjunction with the Trigger value specified in Configuration>Preferences>Channels tab.  
 
 
 
NOTE: Press the Trigger button to prepare DigivibeMX for a Trigger recording. The actual recording 
will not begin until the specified Trigger vibration value is reached.   
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Route Data Collection (M20, M30) 
 

Machines in the DigivibeMX database are rarely displayed in the same order that their data would be collected. DigivibeMX allows 
Machines and Points to be grouped and organized into logical Routes that a technician would travel for fast, efficient data 
collection with portable instrument - such as WiSER1X, WiSER3X or the GX-400 USB-connected interface. 

Creating a New Data Collection Route 
To create a new data collection Route, select New Route from the Start Menu options or select the Routes Manager tile. 

 

The Routes window opens. This window will be used to create and manage portable data collection Routes. Click the Blue Plus 
button to create a New Route. 
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The New Route window opens.  

• The data tree view on the left can be expanded to the Machine level 
• Check machines that will be included in the Route 
• DigivibeMX is designed to create a library of Route Files, as new Routes are created. Select or create a Group where the 

Route File will be stored and assign the Route a Name. This will help make the Route easier to recall later for modification 
or repeat collection. 

• Click the double arrow button (Add) to add selected machines to the Route list.  
• The X button can be used to remove a machine or Point from the Route list. 
• Items can be highlighted and moved up or down the Route list using the Up and Down buttons. This allows the Machines 

and Points to be arranged in a logical order for efficient Route data collection. 
• Specific data collection parameters (Reference data channel collection for ODS, Lines of Resolution, FMax, Averages, 

Overlap) can be defined at the Machine, Point or Axis level.  

 

• When satisfied with the Route list and parameters, select Ok to save the route. 
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The New Route is now displayed as an available Route for collection in the Routes window. The window will display all Routes 
created within a Group selected from the Groups panel. Machines in the database can be easily organized into different Routes 
with unique parameters for different data collection purposes. These features allow users to create an ever-growing library of 
data collection Routes that can be recalled and collected at any time.  

 

Select the desired Route and click Start Route to launch the Routes Module and load the Route for data collection. 

 

 

The Routes Module opens with the Machines and Points listed in the order they will be collected.  
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Collecting Route Data 
Route data collection can be performed using any Erbessd Instruments portable instrument. Data can be collected one axis at a 
time using a single-axis wired or wireless accelerometer (EI-WiSER). Data can also be collected from 3 axes simultaneously using a 
wired or Wireless triaxial accelerometer (EI-WiSER3x). Simultaneous collection of Reference Channel data can also be specified 
before the Route is started. As each data Point or Axis is collected, the data is temporarily saved to the database and the software 
automatically advances to the next Point or Axis. If a Point or Axis cannot be collected, the user may simply advance to the next 
Point or Axis. When the Route is complete, the user will be prompted to save all recordings. The Routes Module will remain open 
until closed by the user. 

Start Data Recording (NOTE: Toolbars can be “dragged” and moved around the perimeter of the screen) 

Stop Data Recording 

Save Recorded Data 

Open Routes Window to Select, Modify or Create a Route 

Select a Database 

Toggle Triaxial Data Collection Mode 

Triaxial Axis Orientation 

Reference Channel Collection for ODS 
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Using the Analyze and Functions Menus (M20, M30, Phantom)  

Viewing Vibration Data 
To review collected signal files, select the Open Files tile on the Start tab. This opens the Historic Measures tab. Select the desired 
level of data in the database. Select Open File to open the recording for analysis. 
 

 

The selected recording opens in the Analyze Menu. To add additional channels for comparative analysis (up to 4 channels), for 
dual channel analysis functions, etc: select Add Channel, then select whether to add another channel from the database or 
Browse for an external file (such as an .anl file of a data recording emailed by another user).  

 

  



 
 
 

 70 
 

 
 

Viewing Vibration Data continued (M20, M30, Phantom) 
 

Selecting and Zooming: Magnifying a desired section of waveform or spectrum can be accomplished in a variety of ways. To 
select a section of the waveform or FFT for closer inspection, press and hold the left mouse button then slide it along the graph 
over the desired section to magnify. When the left mouse button is released, the selected section will be magnified. 

 

Magnified view: 

 

To undo the last zoom, click the Undo Zoom button on the toolbar. 
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• To increase/decrease zoom on only one axis, place the mouse pointer over the axis scale and roll the mouse scroll wheel. 
• To move the graph view while zoomed, place the mouse pointer over the desired axis scale. Press and hold the left 

mouse button, then drag the axis scale up/down or left/right. 
• Floating zoom control buttons also appear automatically when the mouse pointer is positioned over an axis. 

 

NOTE: Zooming in on any section of the Time Waveform automatically re-renders the FFT, which will appear to be at lower 
resolution than the FFT of the entire waveform. 

More control buttons appear when hovering the mouse over the X or Y axis. 

• Zoom in 
• Zoom out 
• Set Frequency Limit 
• Set control Horizontal/Vertical 
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Time Waveform/FFT Graph tools (M20, M30, Phantom) 
 

A number of panel control buttons are located above each waveform/spectrum graph. 

 

 

  Click to hide/display channels (more channels may appear if multiple channels are recorded or opened for analysis) 
  

Vertical measurement cursors  
 

Horizontal measurement cursors 
 

  Remove cursors 

 Clear all markers from graph 

 Clear last marker from graph 
 

Copy graph to paste into a document 
  
 Undo zoom 
 
Reset zoom 

Clear zoom 
  
 Expand panel to full screen / collapse panel back to split screen 

Analysis tools 
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Analysis tools dropdown 
Clicking on the Analysis tools dropdown opens a menu of shortcuts. For details regarding each tool, see the next section. Note – 
Band Filter and Preferences are only available via this dropdown menu. Band Filter opens a dialog box that allows several filters 
to be applied: low-pass, high-pass, pass-band and band-reject.  

 

 

 

 

 

 

 

Preferences: Tie/Untie scopes: When tied, the TWF and FFT amplitude units will be 
tied together in a common specified unit. When untied, the TWF and FFT amplitude 
units can be specified independently. 

Low Frequency Attenuation: Applies Low frequency attenuation of the signal below 
11Hz.  

 

Units and FFT Spectrum Windowing (M20, M30, Phantom) 
 

Because Erbessd Instruments technologies capture waveform data on each collection, a recording opened for analysis can be re-
rendered immediately to suit user preferences The Parameters toolbar on the Analyze Menu contains the following options:  

• Window: Hanning is usually the default windowing view for FFT spectra. 
Other options include: Rect, Bartlett, Blackman, Hamming, Kaiser, CosSum 
and FlatTop. 

• Units: Imperial and Metric amplitude units for Acceleration, Velocity and 
Displacement are available.  

• Freq: Frequency units for Hz, CPM and Orders are available. 
• Graph frequency limit: Sets the maximum frequency limit of the FFT graph (according to Freq units selected). 
• Save: Save personal configuration. Keeps the previous 4 settings when analyzing signals for the remainder of the open 

session. Once Digivibe is closed, the settings revert to default. 
• Erase: Clear Personal configuration resets the values of the previous 4 parameters to default. 
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Analysis Menu Tools (M20, M30, Phantom) 
 

The Analysis Menu toolbar features essential functions for analyzing collected vibration data. Depending on screen resolution, 
some toolbars may be collapsed. 

 

Markers: Select Markers from the toolbar dropdown and click on any desired point in the FFT to place 
a marker. Use the Clear button to erase markers from TWF or FFT. The Locate feature shows amplitude 
and frequency where the mouse pointer is located. 

 

Common Markers: May be used to save and recall markers on future recordings for the same point and axis.  

Specific Markers: May be used to save and recall markers for future analysis of the same recording. 
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Scope Tools:  

• Panelized: Multiple signals are displayed in separate panels. NOTE – To enable Panelized Scopes, go to the 
Configuration Menu, open Preferences. On the Signal tab, the Allow Panelized Scopes option must be checked.  

 

When turned off, the signals are combined into one panel. 
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• Range Selector: Breaks up the entire spectrum into ranges. Select the desired range by clicking on it. 

 

• Visible Legends: Toggles the display of the Legends section on the right side of the TWF and FFT graphs: 

 

FFT tools:  

• Harmonics: Specify the number of Harmonic cursor lines desired (8 in 
this example), then select the vibration peak from which harmonics 
will be calculated. Cursor lines denoting the harmonic frequencies 
appear on the graph. Use Remove Cursors to clear cursor lines from 
the graph. 

 



 
 
 

 77 
 

 
 

• Sidebands: Specify the number of Sideband cursor lines desired (3 in this example), then click the vibration peak to be 
analyzed for Sidebands. A blue line for each Sideband of the selected peak appears on the graph. Moving the mouse 
pointer laterally across the graph will expand/reduce the sideband spacing. When the desired sideband spacing is 
achieved, click again to freeze the sideband cursors in place. Use Remove Cursors to clear cursor lines from the graph. 

 

 

• Averages: Specify the number of averages used to produce the FFT. The default FFT view is one average. Increasing the 
number of averages reduces the appearance of random outlying peaks and periodic occurrences, showing a truer 
representation of repeating events in the FFT. However, increasing the number of averages lowers FFT resolution. 

This is the DigivibeMX® default FFT view, which is produced using 1 average: 

 

This FFT shows the same frequency range, but was averaged 10 times: 

 

  



 
 
 

 78 
 

 
 

 

• Overlap: Specify the percentage of Overlap when changing the Averages to greater than 1. The default is 0%.The 
following FFT was produced using 10 Averages and the default 0% Overlap: 

 

 Changing the Overlap to 50% results in the following FFT: 

 

• Decibels: Converts and displays the FFT in Decibels. 
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TWF tools 

• Circular Time Waveform: Opens the Select Frequency window. Select the desired frequency from the dropdown or 
enter it manually. 

 

The Circular TWF is rendered in a new tabbed panel, based on the selected frequency. Graph Appearance options include Line, 
Area or Points. Frequency, Start time and Cycles can all be changed after the graph is opened. Changes will be re-rendered 
immediately. The Copy button allows copying the graph for pasting into a Word document, email, etc. 
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• Transient: Selecting Transients opens the Cursors window. Click the desired frequency to analyze in the TWF. Then click 
the desired instance to inspect for transient events in the Time Waveform. Moving the mouse cursor laterally across the 
Time Waveform changes the sideband cursor frequency spacing. (Zooming in on the affected part of the Time Waveform 
can help narrow down cursor spacing to the desired frequency interval). Use Clear to remove cursor lines from the graph. 

 

 

TWF Distance/FFT Distance: Calculates and displays the horizontal or vertical distance between any two selected points on the 
Time Waveform or FFT graph. Use Clear to remove marked areas from the graph. 
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Functions Menu Tools (M20, M30, Phantom) 
 

In addition to the Analyze Menu, the Functions Menu also features a number of essential tools for analyzing collected vibration 
data: The Functions Menu tools are divided between two toolbars: Single Channel functions and Dual Channel functions.  

Single Channel functions 
Circular TWF: Explained previously. If multiple channels are opened for Analysis, all will be rendered. 

Waterfall: Produces a color-coded 3D representation of a recorded signal as both Time Waveform (0-pk) and FFT. This unique 
tool allows users to observe how frequency amplitudes in the FFT may fluctuate over time. 
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Spectrogram: Produces a color-coded bar graph representation of vibration severity by frequency range. Interval, Resolution, 
Windowing format and Frequency units may be changed. The graph will immediately re-render. The Copy button copies the 
graph for pasting into a Word document, email, etc.  

NOTE: Lines may initially appear very small. Zoom the view as necessary. Position the mouse pointer over the desired axis and 
scroll up/down to zoom the axis in/out. Click, hold and drag an axis in the desired direction to reposition the graph. 

 

 

Frequency 0: Opens a small window displaying the Cross-by-0 Frequency. 

 

 

FFT: Displays the FFT in full screen mode. This the same as maximizing the FFT portion of the analysis screen. 
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Dual Channel Functions toolbar 
 

The following tools are provided for dual-channel analysis. 

Bode: Displays machine start-up or run-down data collections in Bode Plot format. (Open vibration data, add speed data channel, 
select Bode, select Channel 1 for vibration – Bode plot opens. Select how you would like data to be plotted.) 
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Phase: Displays the phase angle differences between a measured point and its reference point, across the entire frequency 
spectrum. 

 

 

Cross Spectrum: Displays two channel data as a Cross Spectrum FFT graph. 
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FRF: (Frequency Response Function): Displays a FFT-style graph measuring the output spectrum of a system, in response to a 
stimulus. 

 

 

Coherence: Displays a spectral representation showing the relationship between two signals or data sets. 
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Orbit: Displays a static or dynamic graph representing the end travel of a rotating shaft. 

 

NOTE: Orbit Analysis requires simultaneous data collection in the vertical and horizontal planes. In order to accomplish this, one 
would need triaxial, biaxial or two single-axis accelerometers. A single triaxial or biaxial accelerometer could be positioned 
vertically. With two single axis accelerometers, one must be positioned horizontally and the other vertically – each collected on its 
own channel. Start a new analysis and collect both channels simultaneously.  

Create an orbit plot from the data by clicking on the Orbit button located in the Functions Menu toolbar. If the collected data is 
identified as Horizontal and Vertical, DigivibeMX can determine which channel is vertical and which is horizontal. 

 

 

In the orbit view, the duration of the drawing can be adjusted in milliseconds. The rendering speed of the graph can be adjusted 
by percentage. It is also possible to zoom in to fit an appropriate size. The image can be copied from DigivibeMX®with the right 
mouse button and pasted elsewhere as a still image. 

Observe the dynamic graph in video format by clicking the Start button. Playback can be paused and restarted at any point. A 
slider bar under the Pause and Stop buttons can be used to manually scroll through the entire Orbit plot. 

Below the configuration settings on the right-hand side are Filter tools that can be used to filter Low Pass, Pass Band, Pass High 
and Block Band to improve the graphical interface. 
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Envelope Alarms Menu Tools (M20, M30, Phantom) 
 

Overall alarm values for Displacement, Velocity, Acceleration and Acceleration Envelope can be set for Machine Points when a 
new Machine is created in the database. These alarms are useful for ensuring that any source of vibration across the entire FFT 
spectrum will trigger a change in the Machine’s alarm status. However, due to their unique design, installation or functions, some 
machines simply do not run within normal parameters across all frequency ranges. In such cases, a user may want to wrap an 
alarm envelope around an existing “ideal state” data collection. They may also wish to reduce or increase alarm tolerances at 
certain frequency ranges. Capabilities to establish and monitor these types of customized alarms are provided on the Envelope 
Alarms Menu. To set a new alarm envelope around an existing data collection, first use Open Files and select Open File to open 
the desired recording. Then proceed to the Envelope Alarms Menu. 

Show Alarms toolbar 
 

The following tools are provided to view or hide alarms that are set around a 
recording. 

Show Alarms: Displays all envelope alarms set on the open recording (if any 
alarms have been set).  

Green / Yellow / Red: Toggles on/off the individual Green, Yellow and Red 
alarm envelopes. 

 

Configuration toolbar 
 

The following tools are provided to set an alarm envelope around a recording, and provide an overview of the Machine’s 
current envelope alarm conditions. 

Report: Displays the envelope alarm status of all Points and Axis for the Machine to which the current recording belongs.  

Set Alarms: Opens the Alarms Wizard to establish or edit an envelope alarm around the displayed recording. Note-The 
collection must be set at the axis level to properly function. 

 

Setting an alarm envelope around a recording 
 

With the desired recording open, select Set Alarms.  

NOTE: Source signals for Alarm Enveloping must be opened from the Axis level 
of the database. If the FFT is not visible after clicking Set Alarms, the source 
signal was probably opened from a higher level of the database (Point or 
Machine level). 
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The alarm enveloping window opens, displaying the Machine and Point to which the recording is assigned. The arrow 
buttons can be used to advance to the previous or next Point in the database. Units appear as displayed in the original 
Analysis window but can be changed to alarm the recording for Displacement, Velocity, Acceleration or Acceleration 
Enveloping. To set the alarm envelope parameters, click the Wizard button to launch the Envelope Alarms Wizard. 

 

Use the Envelope Alarms Wizard to specify the increased vibration tolerance across the entire FFT Spectrum, before an alarm 
condition changes. These values may be defined by a percentage increase or an absolute value. Minimum indicates the amount of 
resulting alarm envelope from the highest amplitude documented in the enveloped recording. Checking the boxes displays the 
checked band on the Alarm Enveloping window reading. When satisfied with the overall envelope parameters, click Next to 
proceed. 

NOTE: Alarm envelopes can be adjusted at specific frequency ranges later in the process. 
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The next screen allows users to select the number of peaks to be alarmed. Indicate the desired number of peaks to alarm, then 
click Next to proceed. 

 

The next screen allows users to specify the frequency range offset (in CPM) around each enveloped peak in the FFT Spectrum. 

 

 

When satisfied with the overall envelope parameters, click Finish. 
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The alarm enveloping window now displays the new envelope alarms around the FFT Spectrum. If the alarm bands are not 
immediately visible, it may be necessary to zoom out the view.  

 

To adjust the alarm bands in specific frequency ranges, click and hold the red x on the desired alarm envelope nearest the 
beginning of the desired frequency range. Drag it to the desired frequency and amplitude, then release. Then click and hold the 
red x nearest the end of the desired frequency range and drag it to the desired location, then release. Click Save when finished to 
save the envelope alarm. 
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3D Menu Tools (M20, M30) 

 

ODS 
Operating deflection shape (ODS) Is a type of analysis capable of animating the deformation of a mechanical system at a selected 
frequency. The ODS analysis animates the machine’s movement at each measurement point during operation, relative to a 
common stationary point. These animations can be very useful by defining areas of structural weakness and identifying areas of 
mechanical clearance. In resonance cases, the ODS analysis can provide an estimate of the mode of vibration of an excited 
natural frequency. 

ODS Modeling Requires Reference Channel Data 
At the present time, Reference Channel data 
collection is only possible in Route mode, using 
portable interfaces. The Phantom system is not 
capable of collecting the simultaneous Reference 
Channel data that corresponds with Phantom 
Vibration triaxial or biaxial sensor data 
collections. 

ODS modeling data may be collected as part of 
every data collection Route, simply by adding 
simultaneous Reference Channel data collections 
to be recorded at each point. With Reference 
Channel data collection enabled, an extra 
Reference Channel accelerometer must be placed 
somewhere on the machine near the vibration 
data collection points. The Reference Channel 
accelerometer remains in place while all other 
machine data points are collected. This allows 
the vibration at all measured points to be 
compared with the stationary reference point, 
and therefore compared among themselves with 
the reference point acting as a constant. The 
Reference Channel is indicated in the software 
with the letter "R". 
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Analysis of ODS Data 
Select the machine you want to analyze and start the ODS function: 

 

Select ODS data collection route by date and RPM. 
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Select Play to begin the ODS animation of collected data. 

 

 

The animation speed of the ODS model can be increased or decreased using the slider  control. The effects of vibration can be 
reduced or increased with the Amplitude control. A still image or moving .gif file can be copied for Word documents or emails 
using the Copy or GIF controls. Axis of orientation can be swapped as desired. 
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Phase Analysis of ODS Data 
Select the Points tab and click on the Data cell of the point you want to analyze: 

 

The phases are calculated between all points with respect to the Reference: 
• Horizontal 
• Vertical 
• Axial 

 
Subtract the phase of the point and direction that interests you with respect to the 2nd point of interest and thus obtain the 
phase between them (for example the Phase between 1H and 1V = 358 ° - 238 ° = 120 °). 

IMPORTANT: Make sure that the measurements were taken in the directions indicated in figure 3D, otherwise select the 
"Inv" box to reverse the direction at a given point (the arrow changes direction). 
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Guide to Configuring a 3D Model 
 

To import a 3D model go to the Tools Menu and click on 3D Model Editor. 

NOTE: Supported file formats in DigivibeMX for 3D machine models are .3ds, .xaml and .obj. 
 

 

The Edit ODS window opens. Select a New 3D Object: 

• From gallery to modify a file already in the gallery 
• From file to import and modify a new machine ODS file 
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Clicking on From file opens the default folder created by DigivibeMX to store 3D files: 

 

Select the desired file and click Open. 
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The 3D image is shown in the Edit ODS tab. The cube in top right corner can be mouse-controlled to spin the image in 3D. 

 Click on the Show Axis label button. An axis graphic is shown at the lower left of the screen. Use the axis orientation buttons to set 
the axes as desired for the machine. 

 

Next, add the number of waypoints you need, or delete the ones you do not need using the add or delete buttons. 
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Clicking on the Data field beside a point opens a position window and places axial arrows onto the diagram. Click the Locate 
button and it will flash red. Click on the diagram to set the location for this point. Then click on the Selected point button on the 
pop-up window. Use the up and down arrows in the X, Y and Z fields to fine-tune the position of the chosen point on the diagram. 
Repeat for all points. 
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Click on the Save button to save the 3D model to the clipboard for 
use on other machines.  

You can add this custom machine to an existing category folder or 
create a new one: 

  

You can now assign this 3D model to any machine in the Database. 

Go to the Database Menu and open Machine Manager: 

A 3D model may be applied when creating a new machine or editing an existing one. Select the group from the drop-down box. 
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Then select the desired Model from the Group list: 

 

The model is now displayed as part of the machine configuration: 
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Phantom Menu Tools (M30, Phantom) 
 

Phantom Menu Tools are exclusively used with the Phantom wireless Machine Health monitoring system. 

NOTE: In the M30 version of DigivibeMX, the Phantom Menu may not be visible when the software is activated. To display the 
Phantom menu, go to the Configuration Menu and open Preferences. On the Phantom tab, check the Show Phantom Menu box. 
The Show Alarms Messages section allows the length of time to be set for Phantom sensor alarm messages to be displayed at the 
bottom of the DigivibeMX screen.  

 

 

The Wizard is used to add, replace, edit, or delete Phantom sensors in the 
database. For details see the Phantom Setup Guide, included with software. 

The Status Devices window information includes firmware version, battery 
level, signal strength, and time of the latest update. 

The Signal Strength button opens a window for display of signal strength info for Phantom sensors connected to the 
same network as the device running DigivibeMX. Hint - The Status window contains the same information at-a-glance 
without needing to be on the same network. 

Add GPIO Sensor provides a shortcut to the General purpose I/O (GPIO) sensor administration window. This function 
is also included in the Phantom Wizard. 

Power Off Configurations: This is a shortcut to the Power Off Configurations window. This function is also included 
in the Phantom Wizard. 

Alarms Set up: Is a shortcut to administer Alarm Notification thresholds for Phantom sensors. This is also found in 
the  Phantom Wizard as part of adding or editing a Phantom sensor . 

 

NOTE: For detailed information about configuring Phantom sensors, please review the Phantom Setup Guide included with 
system purchase. 
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Tools Menu Tools (M20, M30, Phantom) 
 

The Tools Menu features six toolbars: 

 

Severities toolbar 
 
• ISO 10816: Opens the ISO 10816 machine vibration severity chart (velocity units). 
 

 

 

• Envelope: provides Acceleration Envelope vibration tolerances for 3 general machine classifications. 
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Bearings toolbar 
 

• Add Bearing: Opens the Bearing Finder window. DigivibeMX v11 features a bearing database containing fault 
frequencies of over 40,000 common bearings from major manufacturers. Bearings may be permanently assigned to a 
machine measurement point, or specified during analysis. The Bearing database features a Search function, a 
Manual function for adding new bearings and fault frequencies to the database, and a Calculator to calculate bearing 
fault frequencies using bearing component measurements. Bearings may also be  administered using the Machine 
Manager, in the Points field.  

 

• Bearings Info: Opens the Bearing database.  
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Gearboxes toolbar 
• Add Gearbox: Opens the Gearbox window to add, edit, or delete a Gearbox from the database.Gearboxes may now also 

be configured using the Machine Manager, in the Points field. Click the Add button to begin. 

 

 

o Manufacturer: Select from previously configured list or click on this field to add a new Manufacturer. 
o Name: Enter the name of the new gearbox. 
o Description: Add any desired notes. 
o Step Name: Add the step name to the Step-1 panel. 
o Input: Enter the number of teeth. 
o Input Bearings: A bearing configuration may be added by selecting the Bearings button. 
o Output: Enter the number of teeth. 
o Output Bearings: Add an output bearing, if desired. 

Select the button to configure another step in the Gearbox configuration. 

 

Click Save when finished. 
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• Gear Frequency: opens the Gearbox library, as detailed in the Create a New Machine in the Database>Machine Manager 
section of this manual, see page 44. 

Extras toolbar 
• Print Machine Codes: This function has been moved to the Machine Manager as part of the machine configuration. 
• 3D Model Editor: Opens the 3D ODS Control Panel for editing or importing 3D ODS models. 

Advance Tendency 
Opens the Advance Tendency dashboard for detailed machine health severity analysis. The Dashboard window contains 5 panels 
of Severity information. Severity values provide an indication of overall machine health and should not be confused with the 
values of collected data (vibration, temperature, etc).  

Severity values are as follows: 0-1=Inoperative, 1-2=Excellent, 2-3=Satisfactory, 3-4=Unsatisfactory, 4-5=Poor    

 Data panel – Displays the average severity of machines or points under the database level selected, for the slope interval 
specified in machine configurations.  

 Severity panel – Chart display of the average severity on machines or points under the database level selected, for the 
slope interval specified in machine configurations.  

 Last Severities Average panel – Displays average severity based on the most recent data collection. 
 Severity & Slope panel - Provides a chart overview of average machine health severities and the degree of change 

between the last two recordings. 
 Trending panel – Displays a severity trend for all historical readings in the database. 

The data displayed is determined by the database level selected – Company, Area, Machine or Point. Clicking the arrows button 
on any panel opens it to a full-size window view. 
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Data Panel 
The Data panel provides a tabled overview of machine health data for the database level selected, as follows: 

 

• Area: The area in which the data was collected. (When database level Company is selected) 
• Machine: The machine on which the data was collected. (When database level Company or Area is selected) 
• Point: The monitoring point where the data was collected. (When database level Area or Machine is selected) 
• Axis: The direction in which the data was collected. (When database level Machine or Point is selected) 
• Severity (Average): Average severity is calculated using the most recent RMS values collected, versus the ISO or User-

defined alarms for the specified slope interval (days) in the machine’s configuration. 
• CLE – Calculated Life Expectancy (Average)(Days): The machine’s estimated full lifespan from new. 
• Severity (Maximum): The maximum severity of any historical data collection at any point/axis 
• CLE – Calculated Life Expectancy (Minimum)(Days): The estimated days for the machine to deteriorate from green alarm 

status to red alarm status.   
• MTTF – Mean Time To Failure (Days): The estimated days remaining until the machine deteriorates from current alarm 

status to red alarm status. 
• Vel (Maximum): The maximum Velocity of any historical data collection at the point/axis. 
• Env – (Maximum): The maximum Acceleration Envelope value of any historical data collection at the point/axis. 
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Severity Panel 
The Severity panel provides a ring chart overview of current machine health severities, based on the most recent recordings. (0-
1=Inoperative, 1-2=Excellent, 2-3=Satisfactory, 3-4=Unsatisfactory, 4-5=Poor) 

Ring segments are divided equally among the next lower level of database, beneath the level selected (Areas when a Company is 
selected, Machines when an Area is selected, etc.). Colors are only intended to distinguish between ring segments. Colors are not 
an indication of severity or alarm status. 

 

 

Last Severities Avg panel 
The Last Severity Avg panel provides a bar chart overview of average machine health severities, based on the most recent 
recordings versus any currently-assigned alarm values: Velocity, Acceleration Envelope, Acceleration and/or Displacement. (0-
1=Inoperative, 1-2=Excellent, 2-3=Satisfactory, 3-4=Unsatisfactory, 4-5=Poor). 
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Severity & Slope panel 
The Severity & Slope panel provides a chart overview of average machine health severities and the degree of change between the 
last two recordings. The circle position on the graph indicates the current severity. The size of the circle indicates the slope of 
change between the last two recordings (whether increased or decreased). Smaller circles indicate little change between the last 
two recordings. Larger circles indicate a greater change between the last two recordings.   (0-1=Inoperative, 1-2=Excellent, 2-
3=Satisfactory, 3-4=Unsatisfactory, 4-5=Poor) 

 

 

Trending Panel 
The Trending panel plots the highest velocity and acceleration envelope severities recorded each day, within the database level 
selected. (0-1=Inoperative, 1-2=Excellent, 2-3=Satisfactory, 3-4=Unsatisfactory, 4-5=Poor). 

 

Exports toolbar 
• Export to UFF58: When a signal is open for analysis, this button will export the selected raw data (time waveform 

and/or FFT) to a file in UFF58 format.  
• Export to ASCII: When a signal is open for analysis, this button will export the selected raw data (time waveform 

and/or FFT) to a file in ASCII format. 
• Export to CSV: When a signal is open for analysis, this button will export the selected raw data (time waveform 

and/or FFT) to a file in CSV format.  
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Imports toolbar 
 

• UFF58 Import: Imports signal data for analysis from a UFF58 format file. 
• ASCII Import: Imports signal data for analysis from an ASCII format file. 
• CSV Import: Imports signal data for analysis from a CSV format file.  
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Other Start Menu Tools 
 

 

Balancing 
For details regarding In Situ and SBS balancing, see Balancing User Guides. 

Reporting (M10, M20, M30) 
Click New report on the Start Menu to open the Reports Manager window. 

There are two types of automatic reports that can be generated with DigivibeMX®: 

1. Machines report 
2. Severity report 

Click on Machines or Severity and select machines from the list. 
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Set the Filters: Choose either Last measure only or pick a Date range. 

 

Set desired info for Vibration and Extra Parameters on the Units tab. 

 

The Spectrum tab contains additional settings for FFT, Frequency/Zoom and Envelope alarms. 
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The Output tab settings include Report type and Template selection. 

 

Viewer: opens a preview window. You can also export to PDF or print the doc from this window. 

 

 

Report editor: Opens DevExpress Report Designer to allow custom report templates to be built. Details of DevExpress Report 
Designer usage are not included in this Guide. Details can be found on the DevExpress website: 
https://docs.devexpress.com/XtraReports/14651/get-started-with-devexpress-reporting 

 

https://docs.devexpress.com/XtraReports/14651/get-started-with-devexpress-reporting
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PDF: Outputs the report in PDF format to a folder of your choice. 

Click Generate Report when all selections have been made. 

 

Sample Machines report (M20, M30) 
 

 

The Title page of the Machine report contains a summary of all machines selected. The data tree on the left can be used to 
naviagte directly to a machine. 

Each Machine has a trend graph covering the chosen time window. The requested vibration data and Extra parameters info are 
displayed for each day of the reporting period.  
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Sample Severity Report (M20, M30) 
The Severity report is a summary of the requested info, sorted by date. 

 

 

Trends 
The Trends button opens the Tendencies Dashboard, this is the same as clicking the Trends Tile on the Start tab. See full 
description of the Tendencies Dashboard on page 41. 
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Product Registration 
 
DigivibeMX® is a registered trademark and therefore requires an activation via the internet that can be made using the “Activation" 
option in the "Help" menu. It is essential to carry out this operation as otherwise the program could be suddenly deactivated.  
  
Updates 
  
DigivibeMX® is an application that is constantly updated. The software automatically checks for updates upon startup, and 
opens a dialog box if a newer version is found. Users can proceed with the update or optionally defer to update later. These 
updates are published on the Erbessd Instruments® web page and are free to all users of Erbessd Instruments within the 
installed version. 
  
License  
DigivibeMX® is distributed with the license to use the software in a single equipment, reason why is prohibited any total or 
partial reproduction of said software, as well as the unauthorized distribution of the same one. 
  
Security and Copyright © 
  
DigivibeMX® is distributed without a registration code because it is part of a set of parts, however each edition of 
DigivibeMX® is compiled with the data of the company and the person to whom it has been delivered, which does not 
prevent its operation, but is used to track the source of illicit software on the internet. The owner of the software that is 
unlawfully distributed will be liable to the corresponding legal penalties for illicit distribution of copyrighted material. Also, 
all the updates for that edition will be canceled. 
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